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Microsoft Word: Exercise 1 
 

Word Basics 
 

In this exercise you will learn about: 
 Using tools: Tabs, Ribbon, 

Toolboxes, and Buttons 
 Zoom feature 
 Highlighting text 

 Paragraph marks 

 Copy and Paste functions  

 Font name and Font size 
 Common keyboard operations 
 Bold, Italics, and Underline 

 Vocabulary (underlined words) 

 

Option 1: 

1. Click on the START menu. 

 Click on PROGRAMS  
or ALL PROGRAMS.   

 Click on  
MICROSOFT OFFICE 

 Click on  

MICROSOFT OFFICE WORD 2007. 

 

 
 

Option 2: 
 

Sometimes the program you want is already in 
the START menu. 

1. Click on the START menu. 

 Click on  

 
MICROSOFT OFFICE WORD 2007. 
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2. Now the program, Microsoft Word, is open.  Look at the screen.  Are the 

words Microsoft Word at the top of the screen? 
 

Note: the name of the document is 
in front of the words Microsoft Word. 

 

 

3. Slowly Move the Cursor across the 

Ribbon icons.  It looks like the picture 
below.  Don’t Click on any of them.  

When you point to a picture you will 
see the name for that picture or 

button. 
 

4. Type the alphabet in lower case letters, no spaces, as shown below: 
 

abcdefghijklmnopqrstuvwxyz 

 

5. The letters look so small, they are hard to read.  Rather than change the 
size of the print, let‟s change the size of the document on the screen.  This 

will make the document easier to work with, but not change the finished 
product if the document were to be printed. 
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6. The Zoom feature is located in the lower right corner of your screen.  It is a 

bar with a minus button on the left side and a plus button on the right.  To 
the far left of the bar is „100%‟ if the screen is operating in „normal’ or 

„default’ mode.   

 

7. The Zoom Feature can be used two ways:   
 

1)  Click the Plus or the Minus buttons until you reach the desired size.  
The document will increase or decrease in degrees of 10.   

 
2)  Move the arrow in the middle of the bar with the mouse: Click on the 

arrow and drag it left or right.  This option is good for practicing mouse 
control.   

 
(Note:  Try to keep the final zoom between 120% and 150%) 

 

8. The document has been zoomed to what percentage?  ________________? 



 

Word Basics 4 Rev 3.2010 

 

9. Click and Drag from the “a” to the “z”.  this is called Highlighting.  When 

all the letters are highlighted.  Take your finger off the mouse.  Practice this 
a few times. 

 

10. Another way to highlight the letters is to Click on the place before the letters 
begins so that the cursor is there.  Use your left hand to Hold Down the 

SHIFT key.  Use your right hand to Press the RIGHT ARROW key as many 
times as needed until all the letters are highlighted. 

 

11. A third way is called Highlighting a Row or a line of text.  Do not use this 

for a single word.  Move the mouse arrow into the left margin next to the 

row to be highlighted and Click. 

 

Margin 



 

Word Basics 5 Rev 3.2010 

12. Now Click the COPY button under the Home tab, in the 

Clipboard toolbox.  The computer will remember and 
temporarily store the text that is highlighted. 

13. Click after the „z‟ to place the cursor there. 

14. Now Click the upper part of the PASTE button.  Look at 

what happened.You should now have two alphabets.  

15. Click on the down arrow next to SELECT in the Editing toolbox to view 

the drop down menu. 

 

16. Click on SELECT ALL.  This is a way to highlight all the words on the page. 

17. Some will get something that will look like the illustration below. 

 

18. Some will get something that looks like the following.  Why? 
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19. To find out Look on the Home tab on the Paragraph toolbox.  The 

answer can be found by turning on the Paragraph marks.  Click the 
button that looks like a Paragraph Mark.  

20. The document should now look something like the illustration below. 

 

21. This feature will show you more than where the paragraphs are. 

 

22. How are spaces illustrated?  ___________________________ 

 

23. How many spaces are between sentences?  ___________________ 

 
 

24. Tab marks are illustrated by the little arrow.  As a default, a single tab 
equals 5 spaces.  The illustartion looks like more, because it has been blown 

up (increased in size).   
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25. Look at the Home 

tab and the Font 
toolbox.  (This step 

will not work if the 
words are not 

highlighted.)  Click 
on the little arrow 

next to “Calibri” to 
look at the drop 

down menu. 

26. Click on another 
Font Name to 

change the way the 
letters look. 

27. Use the Scroll Bar 
to view the entire list 

of options.  

28. Change the 

font 3 times 
for practice. 

29. Now Click on 
the drop 

down arrow 
next to the 

number 11 to 

change the 
Font Size. 

30. Click on a 
larger 

number. 
 

31. Click between the “n” and the “o” in the first alphabet to place the blinking 
cursor there. 

 

32. On the keyboard Press the BACKSPACE key several times to erase 
everything before “o”. 

 

33. Next Click just after the “d” in the second alphabet to place the blinking 
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cursor there. 

 

34. On the keyboard Press the DELETE key several times to erase everything 

between the “d” and the “o”.  On the Laptop it is in the far upper right-hand 
corner. 

 

35. Highlight all of the text using any one of the ways practiced earlier.   

36. On the Home tab under the Paragraph toolbox, 

Click on the CENTER button. 

 

37. The text should still be highlighted.  On the 

Home tab under the Font toolbox, Click on 
the B button to make the text Bold.  

 

38. Click on the I button in the Font toolbox to 

make the text Italicized. 

 

39. Click on the U button in the Font toolbox to 

make the text Underlined. 

 

40. Exercise 1 almost 

complete.  Ask a teacher to 

check your work.  The teacher 
will sign in the box. 
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Vocabulary 
 
Below are the definitions for some of the words found in this exercise.  They were taken from the 
Longman Dictionary of American English.  Be aware that the definitions cited may not be the only 
meaning for a particular word. 
 

Cite To mention something as an example or proof of something else:  The mayor cited 
the latest crime of figures as proof of the need for more police.  THESAURUS:  
mention, refer to, note, raise, allude to, bring up 

Default The standard way in which things are arranged on a computer screen or in a program 
unless they are changed by the user 

Definition A phrase or sentence that says exactly what a word or phrase, or idea means:  
What’s the definition of “Deformation?”  |  a dictionary definition. 

Feature An important, interesting, or typical part of something:  Anti-virus software is a 
standard feature in all our computers.  |  One of the best features of this camera is 
its size.  THESAURUS: characteristic, quality, trait, attribute, property, aspect. 

Font A set of printed letters that is a particular size and shape. 

Function The usual purpose of a thing, or the job that someone usually odes:  What’s the exact 
function of this program?  |  A manager has to perform many different functions. 

Italics A type of printed letters that lean to the right:  This example is printed in italics. 

Thesaurus A book in which words are put into groups with other words that have a similar 
meaning. 

 
 
 
 
 
This work was created by Neighborhood House.  
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
 
 

41. Click on the MICROSOFT OFFICE button. 

42. Click on CLOSE.  We are not going to save this. 
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Microsoft Word: Exercise 2 
 

More Word Basics 
 

In this exercise you will learn: 

 Quick Access Toolbar 
 Basic keyboard keys 
 Formatting text 

 Cut and Paste 

 Saving a document 
 Using the undo button 
 Vocabulary (Underlined words) 

 

1. Double-click on the Microsoft Office Word 2007 icon on 
the Desktop. 

 

2. The Quick Access Toolbar is located at the top of the screen next to the 
Office button.  In default mode has three buttons:  save, undo, and repeat 

(or redo).  Some of these tools will be used later in this exercise.  Besides 
the 3 default buttons, what other buttons are shown there if any?  Use your 

mouse to help you.   
 

_____________________________________________________________ 

3. The diagram below shows the location next to the Office button, but it has 
been customized. 

 

4. Click the small arrow to the 

far right of the toolbar to get 
a look at the drop down menu 

of options. 
 

5. See the check marks of the 
tools that are already on the 

toolbar. 
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6. Using the options given in the drop down 

menu for assistance, how has the Quick 
Access Toolbar been altered from the one?  

(Which of the options were chosen from the 
drop down menu?) 

 
 

_____________________________________ 
 

 
_____________________________________ 

 

7. Type your first and last name in the blank document.  Capitalize the first 
letter of your first and last name using the SHIFT key. 

8. Press the ENTER key to move down one line. 

9. Type your street address. 

10. Press the ENTER key to move down one line. 

11. Type your city, state, and ZIP code.   
ZIP: A number that you put below the address on an envelope to help the post office 

deliver the mail more quickly.  Now rarely capitalized, it originally stood for Zone 

Improvement Plan. 

12. Press the ENTER key to move down one line. 

13. Type your phone number.  (Phone numbers can be written a number of 

different ways:  651-789-2518 or 651.789.2518.  All are correct.)  Your 
document should look something like this: 

 

 

14. Select All the text.  (On the Home tab in the Editing toolbox, Click the 
drop down arrow next to Select and Click on Select All.)  
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15. To change the font style Change the font size to 18. 

16. Change the font name.  Choose an alphabet that has lower case letters.  
Remember to use the scroll bar in order to see all the choices.   

 

17. Next Highlight just the phone number. 

18. On the Home tab in the Clipboard toolbox, Click on the 
CUT button.  Your phone number will disappear into the 

computer‟s memory. 

19. Click after your name to move the cursor there. 

20. Click the upper part of the PASTE button.  Your phone 
number should appear right after your name. 

 

 

21. Click between your name and phone number. 

22. Press the TAB key to put a space between your name and the phone 

number.  As a default, one press of the TAB key moves the cursor 5 spaces 
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to the right. 

 

23. Click at the end of the 

first line after the phone 
number. 

24. Highlight your full 
name. 

25. On the Home tab in the 
Font toolbox, Click on 

the CASE CHANGE 
button. 

26. Click on the word 

UPPERCASE 

 

27. Click on the UNDO 

button on the Quick 
Access Toolbar.  

This button will let 
you go back, one 

step at a time.  It is 
a good way to 

correct mistakes. 

28. Click the REPEAT 

(REDO) button on 

the toolbar.  This 
button will let you 

go forward one step 
after you have used 

the UNDO button 

29. Click before your phone number and Press the ENTER key. 

30. Now Highlight your phone number. 

31. Click on the U key on the home tab.  This will underline your phone 

number. 

32. Now Select All the text.  Click the drop down arrow next to Select on the 

in the Editing toolbox.  Click on Select All from the drop down menu. 

33. Center all the text using the CENTER button in the Paragraph toolbox. 

34. In the Font toolbox, Change the font size of your name to 22. 

35. Make your first and last name Bold. 

36. Italicize your address. 
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Does your document look 

something like the illustration 
at the right? 

 

Now you will save this document.  Follow the directions below:  

37. Click on the Office Button. 

38. Click on SAVE AS. 

39. Click on Word Document. 

40. A dialog box will open for My 

Documents.  Find your named 
folder. 

41. Double-click on your named 
folder.  If you do not have one, 

Ask your teacher for help. 

42. Click in the file name box on the 

text that is already there.  The 
text should be highlighted.  Do 

not delete the text.  

43. Type a name for this document.  

Name it  

FirstNameLastInitial Word 2. 
Example: SulinT Word 2 

44. Click on the SAVE button.  
Exercise 2 is almost complete. 

 

 

43. Ask a teacher to check your 

work and sign in this box. 
 

45. Close the document. 

 

 

 

 
This work was created by Neighborhood House. 
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Microsoft Word: Exercise 3 
 

Using Spell Check 
 
This exercise will teach you how to use the computer to help you correct your spelling and grammar.  

When you type a word in this exercise, type it exactly as it is written.  Many of the words are spelled 

incorrectly (misspelled) to show you how you can use the computer to correct your spelling. 

 

Microsoft Word has a dictionary in the computer.  This dictionary knows many English words.  It does 

not know the names of people, the names of places, or words that are not English. 

 
1. Open Microsoft Word  

2. Type computtor  

3. Press the ENTER key.  

4. Do you see a red line on the screen under the word you just 

typed?  The red line means that the computer does not have this 

word in its dictionary. 

 

5. Right-click on the word computtor.  

6. Click on the correct spelling for the word 

that matches the picture. 

 

 
7. Press the ENTER key. 

8. Type: Mowse 

9. Press the ENTER key. 

 

10. On the Ribbon Click the Review tab.  Below is an illustration of some of the Toolboxes on the 

Ribbon:  Proofing, Comments, Tracking. 

 

11. What are the other three toolboxes?  ___________________________________________ 
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12. In the Proofing toolbox, Click on the SPELLING & GRAMMAR button.  

13. The word mowse has a red line, because the computer does not have this word in its dictionary. 

14. Click on the correct 

spelling for the word that 

matches the picture. 

 

15. Click the 

CHANGE 
button. 

16. Click the OK button. 

17. Type: Kibor. 

18. Press the ENTER key. 

 

19. In the Proofing toolbox, Click on the SPELLING & GRAMMAR button.  

20. The dialog box provides suggestions 

for the word ―kibor‖ which is not in 

the computer‘s dictionary.  Use the 

Scroll bar under Suggestions to make 

sure the correct spelling is not on the 

list. 

  

21. If the spelling is very wrong, the 

computer cannot find the correct 

spelling for you.  Highlight the word 

in the dialog box and Type the correct 

spelling:  keyboard. 

22. Click the CHANGE button. 

21. Click the OK button. 

23. Type:  Mukta and Press the ENTER 

key.  
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22. Mukta is a woman name.  The computer does not know 

the names of people. 

Click on the SPELLING & GRAMMAR button. 

23. The name is underlined in red, because the computer 

does not know this word.  Click the IGNORE ONCE 

button. 

24. Now the computer knows that Mukta is not a mistake.  

Click the OK button. 
 

25. Type: addis ababa. 

26. Press the ENTER key. 

27. This is the capitol city of the country 

Ethiopia.  Remember, the computer does 

not know the names of places.  Click on 

the SPELLING & GRAMMER button. 

28. Part of the city name is in red, because the 

computer thinks it is a mistake.  Click on 

the IGNORE ONCE button.  

29. Now part of the city name is green, because 

the computer thinks it is a grammar 

mistake.  The name of a city should start 

with a capital letter.  If it is two words, 

both should be capitalized.  Click on the 

CHANGE button. 

 

30. Type: Salsa verde 

31. Press the ENTER key. 

32. Right-click on the word verde. 

33. Click on IGNORE (or Ignore All). 
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34. Type: his name George.  he is eating 

35. Press the ENTER key. 

36. Sometimes the computer will automatically change the first 

letter of a sentence to a capital letter.  Look at the last two 

sentences.  Is the first letter capitalized?  If not, Capitalize his 

and he. 

37. Click on the SPELLING & GRAMMAR button. 

 

38. ―His name George.‖ is a fragment; it is not a 

complete sentence.  Click between ―name‖ and 

―George. 

39. Type: is 

40. Click the CHANGE button. 

41. When the spell check is complete, Click the 

OK button. 
 

42. Spell check cannot find all mistakes.  There is a problem with the last sentence.  Every sentence 

should have a punctuation mark of some kind at the end.  In this case is should be a period.  

Click after the word ―eating‖ Type a period. 

43. Type: Please turn on the lamb. 

44. Press the ENTER key.  There are no red or green lines, but there is a problem. 

  

45. The correct word is lamp NOT lamb. 

The computer did not show a red line under the word, because lamb is in the English dictionary.  But 

it is not the correct word for this sentence. 

46. Delete the word ―lamb.‖  Type: lamp. 

Remember, spelling and grammar check is very useful, but you still need to look carefully at 

what you type and use your brain! 
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47. Ask a teacher to check your work.  The 

teacher will sign in the box on the right. 
 

48. Close the document.  Do not save.  
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Microsoft Word: Exercise 4  
 

Shared Folders and Fixing Mistakes 
 

 
This is Azeb.  She is an English student. 

You will help Azeb fix the mistakes in her homework. 

 

Follow the directions below to open her homework. 

1. From the Start 

Menu Open ―My 

Documents‖. 

2. Find a folder 

called Computers 

and Literacy. 

 

You may need to 

use the scroll bar 

at the bottom to 

find your folder. 

 

3. Double-click on it to open the folder. 

 

4. Now you will see several other folders.  

Double-click on the Microsoft Word 

folder. 

 

5. Find a document labeled  

My name is Azeb. 

6. Double-click to open the file. 
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7. We cannot work on the document where 

it is, because: 

a. It is in a shared folder. 

b. Other people need to copy it too.. 

Therefore, we need to save the document 

in our named folder. 

Named folder: an individual‘s folder where that 

person‘s documents are filed. 

Shared folder:  a folder where documents are stored 

which are to be accessed/used by many individuals.  

―My Documents ―is a shared folder with many other 

folders inside of it. 

8. To Save the document to your named 

folder, begin by Clicking on the Office 

button. 

 

In the drop down menu, Click on Save As 

because we want to relocate and rename 

the document. 

9. Save this document to your named folder:  

FirstnameLastinitial Corrected 

Homework. 
 

10. To save the document to your named 

folder Open ―My Documents‖ again. 

11. Look at the ―Save As‖ line at the top.  It 

should say ―My Documents‖.  It needs to 

be yourname. 

 

Use the scroll bar at the bottom to look 

for your named folder.  Double-click on it 

to open it. 

 

12. Once you have your folder opened, look 

at the File Name field at the bottom.  

Type in the name: FirstnameLastinitial 

Corrected Homework. 

13. Click Save. 

 

14. Now look at the top of your document.  It 

should now have the new file name at the 

top . 
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15. This is Azeb‘s English homework.  There are a few mistakes. 

a. See the red lines.  These words might be spelling mistakes. 

b. See the green lines.  These might be grammar mistakes. 

c. See the blue lines.  These might be the wrong choice of word. 

Follow the directions to Correct the mistakes in Azeb‘s homework. 

 

 

16. Right-click on the 

word ―tipe‖. 

 

17. Find the correct 

spelling for this 

word: ―type‖. 

18. Click on the 

correct spelling. 

19. Click in front of the word ―My‖. 

20. Click on the Review tab. 

21. In the Proofing toolbox Click on the SPELLING & GRAMMAR button. 
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22. Look at the red word ―Azeb‖. 

 

Is this a mistake?  _____________ 

23. Click on the IGNORE ONCE 

button. 

 

24. Look at the blue word ―wont‖.   

 

Is this a mistake?  ___________ 

25. Click on the CHANGE button. 

 

26. Look at the word ―cando‖. 

 

Is this a mistake?  ____________ 

27. Find and Click the correct spelling 

in the Suggestions list. 

28. Click the CHANGE button. 
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29. Look at the blue word ―bee‖. 

 

Is it a mistake?  ______________ 

30. Is the suggestion correct? 

 

__________________________ 

 

31. Click on the CHANGE button. 

 

32. Look at the next red word, ―Im‖. 

 

Is this a mistake?  ____________ 

33. Click on the correct spelling. 

34. Click the CHANGE button. 

 

35. Look at the last red word 

―emprove‖. 

 

Is this a mistake?  _____________ 

36. Click on the correct spelling. 

37. Click the CHANGE button. 
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38. Look at the green periods. 

 

Is this a mistake?  ____________ 

39. Click on the correct grammar 

punctuation mark. 

 

Word has two suggestions:  …  

(an ellipses) or . (a period). 

What is an ellipsis used for? 

 

____________________________ 

40. Click the CHANGE button.  

41. Microsoft Word cannot find all of the mistakes.  There are 2 more mistakes in this paragraph.  Can 

you find them both and correct the mistakes? 

 

 

 There is no period at the 

end of the second sentence. 

 The third sentence is 

missing the subject:  It 

should read: ‗I want‘. 

 Look at the corrected 

version below. 

 

42. Save this document by Clicking on the Save button on the Quick Access Toolbar. 
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43. Have a teacher check your work. 

The teacher will sign in the box. 

 

44. Open a new Word Document. 

45. Type 6-10 sentences about yourself. 

46. Use the Spell Check feature to correct any mistakes. 

47. Save it to your named folder:  FirstnameLastinitial Myself. 

48. Have a teacher check your work. 

The teacher will sign in the box. 

 

 

 

 

Vocabulary 

 

Below are the definitions of some of the words found in this exercise.  They were taken from the 

Longman Dictionary of American English.  Be aware that the definitions cited may not be the only 

meaning. 

 

Dash A mark (—) used in writing to separate parts of a sentence. 

Ellipsis The sign (…) used in writing to show that some words have deliberately been left out of a 

sentence. 
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Microsoft Word: Exercise 5 
 

Cutting and Pasting Internet Images 
Internet Skills 

 

Images on the Internet are put there by someone who has the picture or drawing on his or her own 

computer.  They own the rights to the image.  If we use that image, we are only borrowing it.  We 

cannot use the image in order to make money for ourselves, because of the Copyright Law that says 

that only the person who owns the image is allowed to do that.  Some images on the Internet are 

protected so that we cannot download a copy of them. 

 

You are going to create a document called ―My Favorite Things‖, using images from the Internet.  We 

are not planning to make any money; we are only going to use it in class, so it is all right to copy the 

image. 

 

1. Open Microsoft Word.  This will automatically open a new blank document. 

2. Type the words My Favorite Things.  Remember to capitalize the first letter of each word 

because this is the title of your document. 

3. Press the Enter key twice. 

4. Highlight the Title of the document. 

5. In the Font toolbox, Click on the Bold button. 

6. In the Paragraph toolbox, Click on the Center Align button. 

7. Click below the title so that the blinking cursor is to the left of the screen. 

8. Type the words ―My favorite animal is‖ 

9. Complete the sentence with whatever your favorite animal is.   

10. Save the document in your named folder as: Firstnamelastinitial Favorites.  It should look 

something like the illustration below. 

 

11. Press the Enter key after the end of your sentence.  (Sentences begin with a capital and end with a 

period.  There is also a space between each word.) 
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12. Minimize your document. 

13. Open Microsoft Explorer.  What is a Search Engine?  __________________________________ 

14. What are some examples?  _________________________________________________________ 

Search engines can help you find useful information.  Usually, the information you find on the internet 

is text.  Text means letters, words, and sentences.  Search engines can also help you find images, audio, 

and video. 

Google, Bing, Yahoo, and Ask.com are all examples of search engines.  There are many others. 

 

15. Go to www.google.com.  

 

16. Locate the Google Links. 

17. Click on the link called IMAGES. 

18. Click in the search box.   

19. Type the word for your favorite animal.  

This example is ―giraffe‖.   

20. Press the ENTER key. 

21. You will see many pictures 

of giraffes. 

 

Under each picture is the 

title of the picture, the size, 

and the webpage where 

the picture is located. 

22. Click on one of the 

pictures. 

23. This is the website that put 

this picture on the Internet. 

 

Remember everything on 

the internet was put there 

by some person who has 

the information on his or 

her computer. 

 

Scroll down.  Can you find 

the picture in the webpage? 
 

 

http://www.google.com/
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24. Scroll up.  Next to a small copy of 

the picture, Click on See full-size 

image. 

 

25. Now you see only the image.  Right-click 

on the picture. 

26. Select COPY. 

 

Now the picture is in the  

memory of the computer. 

 

27. Don’t close the Internet browser, but Maximize Microsoft Word, using the buttons on the 

Taskbar at the bottom of your screen. 

28. Your blinking cursor should be below your sentence.  Right-click in the Word document.   

29. Select PASTE.  You will see the picture in the Word document. 

30. Click on the picture.  Put the cursor over the small white circle 

on the corner of the picture. 

31. When the cursor looks like this, Click and Drag to change the 

size of the picture.  If you hold down the Shift key at the same 

time you drag, it will change the size proportionally.  You want 

the end result to be about the size of a postage stamp. 
 

32. When your blinking cursor is at the bottom right corner of your image, Click on the Reference 

tab.  We are going to add a caption to each image we copy. 

33. In the Captions toolbox, Locate the Insert Caption button.  Click on it.  This will open a dialog 

box. 
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34. You will see the blinking cursor next to the words 

―Figure 1‖ in the Caption field.  Add a space by 

Pressing the space bar once. 

35. Type the name of the animal again. 

36. Click the OK button.  The words have been added next 

to your photo in blue. 

 

37. Press the Enter key twice. 

38. Type the following:  ―In my native country there are lots of plants.  One of my favorites is‖ 

39. Complete the sentence and Press the Enter key once. 

40. Minimize the Word document. 

 

41. You should be looking at the internet screen and your 

favorite animal.  Use the Back button to go back one 

screen. 

 

42. Above the small image of your favorite animal, Find 

the Search Box.  Click in it and Highlight the name of 

your animal.   

43. There is no need to delete this word, just begin Typing 

the word for your favorite Plant. 

44. Press the Enter key or Click the Search Images 

button. 

 

 

45. Select an image that you like – remember there is more than one page to view. 

46. Copy and paste that image into your Word document.  Use the Taskbar buttons to bring up the 

Word document on your screen. 

47. Resize the image. 

48. You should still be on the Reference tab.  In the Captions toolbox, Click the Insert Caption 

button.   
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49. The dialog box should now say ―Figure 2‖ in the 

Caption field.  Add a space by Pressing the space bar 

once. 

50. Type the name of the plant. 

51. Click the OK button.  The words have been added next 

to your photo in blue. 

 

52. Press the Enter key twice. 

53. Write 2 sentences about your favorite food. 

54. Find an image of it and Copy it into the Word document.  Remember to space your document like 

you did previously. 

55. Add a caption to this image as well.  Look at the previous steps if you need help remembering how 

to do it. 

56. Press the Enter key twice 

57. Write a sentence about any other favorite thing and Find an image for the document. 

58. Add the caption. 

59. Save the document.   

 

It has already been named, so you only have to click the SAVE button on the Quick Access 

Toolbar.  When you click the button, move the cursor right away.  When the button bounces back, 

your document has been saved. 

60. Spell check your document.  Correct any errors and Save it again. 

61. Print your document or Show a teacher on your 

computer screen.  The teacher will sign in this 

box. 

 

 

This work was created by Neighborhood House. 

This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, 
distribute, transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of 

the work are placed under a similar license, and that appropriate attribution is provided where possible.  
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Microsoft Word: Exercise 6 
Corrections to a Letter 

 

 

This is Jane Doe.  Jane is going on vacation. 

She wrote a letter to her teacher about her vacation. 

The letter has many spelling and grammar mistakes. 

 

In this exercise, you will download a copy of Jane‘s letter 

from the Neighborhood House Network.  You will then 

save the copy to your named folder.  You will correct the 

spelling and grammar mistakes and format the letter to 

make it look better.   

 

To start, follow the step-by-step instructions. 

1. Open Microsoft Word.  

2. Click on the Office Button in the upper left hand corner.  Or use the button on the Quick Access 

Toolbar. 

3. Click on OPEN. 

4. Make sure that MY DOCUMENTS is highlighted on the left.   
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5. Use the scroll bar at the bottom to 

locate a file folder called 

Computers & Literacy (it is 

highlighted in the illustration). 

6. Double-click on it to open the 

folder. 

 

7. The file we are looking for in for our Microsoft 

Word class.  Open the Microsoft Word Folder 

by Double-clicking on it. 

8. Within the file folder locate the file called 

―Jane Doe Letter‖ (it is highlighted in the 

illustration below).  Double-click to open it. 

 

If you get a dialog box that gives you the option 

to “Open as Read Only”, Click the OK 

button. 

9. The Computers & Literacy folder us a 

―Shared Folder‖; therefore, we need to save a 

copy of the the file/document we just opened in 

your named folder so that you can work on it 

individually. 

This process is like taking a piece of paper to 

a copy machine and making a copy for 

yourself.   
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10. Since we have opened the document, we 

have already put the original onto the 

copier glass.  However, we cannot just 

press a button to make the copy.  We 

need to make sure it gets to the right slot 

in the copier before we ‗press the 

button‘.   

To do that, Use the Office button and 

Select Save As.   

11. Find your named folder and Double-

click to open it. 

 

12. Look at the ―Save in‖ field at the top of the dialog box:  Is there a little folder with your name 

after it?  If not, ask a teacher for assistance. 

13. In the ―File name‘ field, Use the naming convention below: 

FirstnameLastinitial Jane Doe Letter 

14. Click the SAVE button.  Now you have made the copy.  Is the new name of the document in the 

Title bar at the top of the screen?  If it is, you have made the copy successfully. 

15. Remember from Exercise 4, red lines mean that a word is misspelled or that the computer does 

not know the word.  Green lines mean that there might be a grammar mistake.  These lines are 

only there to help you when you are typing.  They will not be on the paper when you print your 

document. 

16. Let‘s change how the letter looks.  This is called formatting. 

17. Highlight Jane‘s name and address.  Change the font to Arial. 

18. Change the font size to 14.  Make it Bold. 

19. Click on the align center button to move the address to the center of the page. 

20. Highlight the date.  Click on the align right button. 

21. Click in front of ―dear Leslie‖. 

22. Press the ENTER key.  This moves the words down. 

23. Use the ENTER key to make spaces between the lines as shown below: 
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24. Highlight the text from the date to the end of the letter.  Change the font to Arial 12 pt. 

25. Highlight the words May 3
rd

, 4
th

, 5
th

, and 6
th

.  Underline them. 

26. Move the cursor to the beginning of the document.  Click on the Review tab. 

27. In the Proofing toolbox, click on the Spelling and Grammar button.   

28. For each mistake, Click either CHANGE or IGNORE.  Finish the Spelling and Grammar check. 

29. After you finish the spell check, look for other words in the letter that might be spelled wrong.  

Do you see the word vesting?  This word is not correct.  It should be visiting.  Spell check did not 

mark this mistake because this is an English word, but it is not correct in this sentence.  Please 

Change it. 

30. Highlight the word Sincerely at the bottom of the letter. 

31. On the Review tab in the Proofing toolbox, click on the Thesaurus button.     

A Thesaurus is a book, like a dictionary.  A Thesaurus helps you find words that mean the same 

thing or similar to the word you have highlighted.  Microsoft Word can help you find similar 

words.  If this feature is turned on, you will see a separate window (titled Research) appear on the 

right side of your screen, showing you other choices for the word sincerely. 



 

Word Basics 36 Rev 3.2010 

32. Choose a new word to replace ―Sincerely.‖ 

Click the drop down arrow next to the word you have chosen.   

33. Click on INSERT.  Close the Research window. 

34. Click on the Print Preview button in the Quick Access Toolbar.  

 

   
 

 

 

You can see what the letter will look like when it is printed on paper.   

 

 

Your document should look like the one below. 

 

Jane Doe 
1234 Green St. 

St. Paul, MN 55101 
 

March 28, 2007 
 
Leslie Gardner 
Functional Work English Instructor 
1600 University Ave. 
St. Paul, MN  55101 
 
Dear Leslie: 
 
I am writing to let you know that I will not be able to attend classes during the first full week of 
May.  I will be visiting my family in Razales, Texas for the Cinco de Mayo festival.  I will miss 
classes on May 3rd, 4th, 5th, and 6th.  I hope that this will not be a problem.  I will be getting 
copies of what I have missed from another student, Ishmeal Baheras.  I believe that I will be 
able to catch up quickly.  Thank you very much and have a great Cinco de Mayo. 
 
Truly, 
 
 
 
Jane Doe 

 

This work was created by Neighborhood House. 
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35.Print your document or Show a teacher on 

your computer screen.  The teacher will sign in 

this box. 

 

 
 
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
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Microsoft Word: Exercise 7 
Formatting Practice 

In this exercise you will practice what you have learned so far.  You will download a 

document from a shared folder.  You will highlight each line and follow the direction in 

that line. 

 

1. Open Microsoft Word.  Use the Shortcut icon on the Desktop. 

2. Click on the Office Button in the upper left hand corner, and Click on Open,  

OR 

Use the OPEN button on the Quick Access Toolbar. 

3. Make sure that MY DOCUMENTS is highlighted on the left in the Open Dialog 

Box.  It should say “My Documents” in the “Look in:” field. 

 

4. Use the Scroll Bar or Arrow at the bottom of the file folders to locate a folder called 

Computers & Literacy.  Note:  it is written in all capital letters/uppercase. 

5. Double-click to open the shared folder called Computers & Literacy. 

6. Double-click to open the Microsoft Word folder. 
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7. Inside Computers & 

Literacy there are other 

folders.  The file we want 

is in the Mircosoft Word 

folder.  Double-click on 

it. 

 

8. Double-click on the file 

named FORMATTING 

PRACTICE. 

9. Now you have opened the 

document.  Since many 

people will be working on 

this document, you need 

to save it into Your 

Named Folder before you 

can begin working on it. 

 

Do you remember how to save a document  

from one folder into another? 

10. To save the document to 

Your Named Folder use 

the Office Button and 

Click on Save As.   

11. Make sure ―My 

Documents is highlighted 

like the illustration, and 

Find your named folder.  

Double-click on it. 

12. Rename the document: 

FirstnameLastinitial 

Formatting Practice.c 

Click the Save button. 
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13. Now Follow the 

directions on the 

document you have just 

saved.  For example, 

highlight line number 1 

and make it bold. 

14. When you have finished 

with all 13 lines, Save the 

file again to save your 

changes. 

 

15. Ask a teacher to check your 

work.  The teacher will sign in 

the box. 

 

 

 

 

 

 
This work was created by Neighborhood House. 
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
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Microsoft Word: Exercise 8 
 

Tables and Rulers 
 

Your boss needs a schedule of your classes and other activities so that she can decide 

who should work each shift.  In this exercise, you will learn how to make a table with 

many boxes.  You will type your weekly activities in this table. 

 

 

To start, follow the step-by-step instructions. 
 

1. Open Microsoft Word. 

2. Click on the View tab of the Menu Bar on the Ribbon.   

 

The Print Layout button should be highlighted in the Document View toolbox.  That is the 

―view‖ on the screen. 

 

What is the third toolbox on the View tab?  __________________________ 

 

What is the second toolbox on the View tab?  ________________________ 

 

3. For this exercise we want the ruler to show up on our screen.  In the Show/Hide toolbox, Click 

the box next to Ruler.   

 

Notice rulers appear just below the ribbon and on the far left side of the screen.  For the exercise 

we will concentrate on the ruler just below the ribbon. 

 

The white space on the ruler shows you the typing area of the document.   

 

What does the blue space represent?  ___________________________________ 

4. Next Click on the Insert tab.  The toolboxes shown in the illustration below are: Pages, Tables, 

Illustrations, Links, and Header & Footer.   

Sunday Monday Tuesday Wednesday Thursday Friday Saturday 
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What are the other two toolboxes?  ______________________________________________ 

 

5. In the Tables toolbox, Click on TABLE. 

 

6. The drop down menu on 

the left will appear.  In 

the illustration seven 

columns across and two 

rows are highlighted.  

This is one way of 

adding a table to a 

document. 

 

Click where it says 

INSERT TABLE.   

The dialog box on the 

left will appear. 

7. Change the number of 

columns in the dialog 

box to match the 

illustration:  7 

 

8. Then Click the OK button.   

 

The table will appear in the document.  Each table is made up of individual blocks called cells.  

The ribbon should also have changed, Adding a detail Tab called Table Tools about Design and 

Layout. 

9. Highlight the top row of cells.  Click in the first cell and Drag to the last cell. 

 

10. We want to be viewing the Design options.  The Design tab should be highlighted. 
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11. Click on the drop down arrow next to the word SHADING. 

12. Click on a light gray box.  The highlighted boxes will turn 

that shade. 

13. Highlight only the bottom row of the table.   

The Design option should still be visible.   

If not, repeat step 9. 

14. This time Click on a different color. 

 

15. Move the Cursor over the bottom line until it looks like this:  

16. Look at the ruler at the top, notice the markings where each column line is located.  Look at the 

ruler on the left; the markings are similar.  Each column is slightly less than an inch wide.   

 

The first row is approximately how tall?  ___________________________ 

17. Click and Drag down until the bottom row is approximately 1 inch.  The illustration below is 

slightly larger than 1 inch. 

 

18. Type Monday in the top left box.  

19. Press the TAB key to move to the next box. 

20. Type the other days of the week. 

21. Type your work schedule in the bottom row.  It can be what you really do every day or you can 

make it up.  You should have at least one thing in each of the cells. 

22. Move the cursor over the table until you see a box with arrows in the top left corner. 
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23. Move the cursor over the box until it  

also looks like four arrows. 

 

24. Click and drag down until you see the dotted outline. 

When you let go, the table should have moved down on the page. 

 

25. Click above the table to put the cursor there. 

26. Click on the CENTER alignment button.    

27. Type the words WEEKLY SCHEDULE above the table. 

28. Change the font name and font size to something you like. 

29. Spell check the document. 

30. Save the document in your named folder:  firstnamelastinitial Weekly Schedule 

31. Ask a teacher to check your work.  The 

teacher will sign in the box. 

 

 

 

 

 
 

 

This work was created by Neighborhood House. 
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
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Microsoft Word: Exercise 9 
 

Using Columns and Indentation 
 

1. Open a New Microsoft Word document.  This may just 

involve opening Word.  If not, Use the Office Button to 
open a New document. 

 

2. On the Home tab in the Paragraph toolbox, turn on the 
paragraph tool by Clicking the Paragraph Button. 
 

Remember, paragraph marks, tabs, space dots, etc. will 
not print out on paper; they are just there to help you 

see what you are doing as you work on a document. 
 

3. Click on the Right Align button on in the Paragraph 
toolbox. 

 

4. Type today’s date. 

5. Press the ENTER button three times.   
 

6. In the Style toolbox, Click the Button that says “No Spacing”. 

7. Click on the Center Align button in the Paragraph toolbox. 
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8. Type the words “Chocolate Chip Cookies”.  See the title is aligned in the 
center of the page. 

9. Press the ENTER key twice. 

10. Click the Left Align button in the Paragraph toolbox. 

 

11. Type the list of ingredients below. 

½ cup Lard 
½ cup Butter 

2½ cups All Purpose Unbleached Flour 
¾ cup White Sugar 

¾ cup Packed Brown Sugar 

2 Eggs 
1 tsp. Vanilla 

½ tsp. Baking Soda 
¾ Bag of Milk Chocolate Chips 

 

12. Press the ENTER key two times.  

13. Type the directions below: 

Directions: Mix the Lard and Butter until creamy.  Mix in some of the 

flour (about half), the brown sugar, white sugar, eggs, vanilla, and 
baking soda.  Stir until ingredients are thoroughly mixed, then blend in 

the remaining flour.  Add chocolate chips and stir.  Drop by spoonfuls 
onto an ungreased baking sheet.  Bake at 375 degrees for 8-10 minutes, 

then enjoy! 

14. Highlight just the ingredients.  

15. Click on the Page Layout tab. 

 

What are the five toolboxes on this ribbon?  They are hard to read in the 
illustration above.  Look at your computer screen for help. 

 
_________________________________________________________________ 
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16. In the Page Setup toolbox, Click on 
the Columns button. 

 

17. We want two columns for our ingredients.  On the drop down menu Select 
the word “two”. 

 

Now the ingredients should be in two columns and look like this: 
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18. Next Click on the View tab.   

 

What are the toolboxes on this ribbon? 
 

______________________________________________________________ 

19. In the Show/Side toolbox, Click in the little box in front of the Ruler tool. 

 

20. See the ruler at the top and on the left side of the screen?  Only the the top 
one if visible in the illustation above.  The white ruler is the width of the 

working ara of the document.  The blue ruler on each side represent the 

margins.   

Notice the little triangle at the far left?  It is called 
the Right Indent marker.   

 

On the left See the two little triangles and the 

rectangle?  They are probably on top of one another. 

  

The upper traingle is called the First Line Indent 

marker. 
 

The bottom triangle is called the Hanging Indent 
marker. 

 
The rectangle is called the Left Indent marker, 

because it moves both the upper and lower triangles 
together if you move it across the ruler. 
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21. Next you will indent the paragraph of directions in the recipe.  We have 
looked at the markers for indenting on the ruler, but what does an indent look 
like when applied to text?  Let‟s Look at the picture below to see what an 

indent looks like.  There are several different ways to indent text. 

 

22. Highlight the paragraph of directions. 

23. We want to indent just the first line of the paragraph of directions.  To do this 

Click on the First Line Indent marker (the upper triangle) and Drag it over 
until it is over the number 1 on the ruler.  This is tricky; take your time.  

See how the paragraph changed. 
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24. Click the UNDO button. 

25. Now Click and Drag the bottom triangle (hanging indent marker) until it is 

under the number 1 on the ruler.  See how the paragraph changed. 

26. Click the UNDO button. 

27. Click and Drag the bottom rectangle until it is under the number 1 on the 

ruler.  See how the paragraph changed. 

28. Look at the right side of the ruler for the Right Indent marker.  Click and 

Drag this triange until it is under the number 5 on the ruler. 

29. Finally Click and Drag the top triangle on the left until it is between the 
number 1 and number 2 on the ruler. 

30. Check your work.  Turn off the Paragraph marks.  Your document should 
look like this. 

 

31. Highlight the title “Chocolate Chip Cookies”.   
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32. Bold and Underline the title. 

33. Save this document in your named folder:  Firstname Cookies 

34. Ask a teacher to check your 
work.  The teacher will sign in 

the box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
This work was created by Neighborhood House. 
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
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Microsoft Word: Exercise 10 
 

Bullets and Clip Art 
 

1. Open a new Word Document. 
 

LISTS and BULLETS 
 

2. Pick one of the following groups of animals.  Type either of the first two as 
written or use the third and create your own list.  The list items must rhyme, 

they do not have to be animals, but they must be nouns. 

 
Father like these animals: 

Bat 
Rat 

Muskrat 

Sister likes 

Cats 
Gnats 

Wombats 

I like these things: 

 

 

 

 

3. Highlight the three nouns (ex., cat, gnat, wombat). 

4. In the Paragraph toolbox Click on the BULLET button.  

5. Now let‟s change how the bullets look.  Click on the drop 

down arrow to see the menu. 
 

6. Notice that the Circle bullet is highlighted.  

Move the mouse over the other bullets and 
look at the list.  As the mouse is moved, the 

bullets in the list change. 

 

 

7. Click on the picture of the square bullets. 

 

8. Click on the drop down arrow again. 

9. Click on Define New Bullet….  The 

Define New Bullet box will appear. 

10. Click on the SYMBOL button.  The 
Symbol box will appear as seen below. 
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11. Find a symbol you like.  To help 

choose, use the scroll bar at the 
right up and down.  Other symbols 

can also be chosen using the Font 
drop down menu.  Click on any 

of the small pictures.  The image 
will be highlighted. 

12. Click on one that you like and then 
Click the OK button.  This action 

will take you back to the previous 
box. 

 

13. In the Define New Bullet Box Click on the 
FONT button. 

14. Change the font size to 16.   
This will only change the size of the bullet. 

15. Click on the OK button.  Click on the OK 

button in the Define New Bullet box.  In 
your document notice that the bullets are a 

different size and shape. 

 

 

CLIP ART 
 

16. Place the cursor at the end of the first bullet and 
Press the ENTER key 4 times.  Do this also after the 

second line of text. 

17. Now you will insert a picture of the first animal.   

We will use Father‟s list as an example.  In the  
Word document Place your cursor below the word 

“bat”.   

18. Click on the INSERT tab.   

19. In the Illustration toolbox Click on the CLIP ART 
button. 

20. Type bat animal in the search box.  We added 

“animal” to limit the search parameter, because we do 
not want pictures of baseball bats. 

21. Press Enter or Click on the GO button. 
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22. Click on a picture of a bat.  The picture will 

automatically copy itself into your document where you 
placed your cursor. 

 

23. Click on the picture in your Word document.  You will 
see a box around it. 

24. Move the cursor over the corner of the picture until it 
looks like an arrow.  

25. Move the Mouse to make the picture smaller. 

26. Now Click and Drag from the picture to the end of the word bat.  The cursor 

will look like a dotted line.  Look at the example below. 

 

27. Click between the picture and the word Bat.  Press the TAB key 2 times. 

28. Check your work.  It should look like either of the examples below.  The first 
is with the Paragraph Marker turned on, and the second is with the Paragraph 

Marker turned off. 

    
 

 

29. Click below the word “Bat”. 
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30. In the Paragraph toolbox Click on the 

little arrow next to the BORDER 
button on the toolbar for the border 

drop down box.   

  

 

 

 

 

 

31. Click on the Horizontal Line 

button. 

 

 

 

32. Save this document in your named folder:  firstnamelastinitial Bullets 

ASSIGNMENT 

33. Repeat the steps you have learned.  

Insert pictures for the other two nouns.   

34. Insert a line between each picture.  When you are finished, all your pictures 

should be on one page. 

35. When you are done Save and Print one copy. 

36. Ask a teacher to check your work.  
The teacher will sign in this box 

 

 
This work was created by Neighborhood House. 
This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License. You are free to copy, distribute, 
transmit, and adapt this work provided that this use is of a non-commercial nature, that any subsequent adaptations of the work are placed 
under a similar license, and that appropriate attribution is provided where possible. 
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Microsoft Word: Exercise 11 
 

Addressing and Labeling for Envelopes 
 

A Page of the Same Labels 

1. Open the program MICROSOFT WORD 

2. Click on the MAILINGS tab of the menu ribbon. 

3. In the Create toolbox Click on Labels.  The Envelopes and Labels Dialog Box will appear.  (Be patient, 

it may take a moment.)  Make sure the Labels Tab is prominent (showing). 

4. Type your address in the large box of the Address Field.  (Addresses used in this exercise are fictional.) 

 

5. In the Print Field make sure the Circle next to the words Full page of the same label is Selected. 
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6. There are many different sizes and shapes of labels.  You 

must choose the one you want.  Look on the box of labels 

or on the sheet of labels for the name and number. 

7. Click on the OPTIONS button near the bottom of the 

dialog box.  The dialog box for Label Options will appear. 

 

Ask your teacher what kind of labels you will be using.  

Ask for the name of the vendor (brand name) and the 

number of the labels (label number).  Write the answers 

below. 

 

Vendor:  ____________________________- 

 

Number:  ____________________________ 

 

8. Under Label Information, if not already 

there, Use the drop down menu in the 

Label Vendor Field to Select the brand 

name of the label company. 

9. In the Product Number Field, Use the 

scroll bar and the Up and Down arrows 

to Locate and Select the correct label 

number.  See the note below. 

10. Click the OK button. 

11. Click on the NEW DOCUMENT 

button. 

 

Note:  Check with your teacher to find out what number 

labels you will be using for this exercise. 

 

A page of labels will appear.  All the labels will look the same.  If you want to change anything, you can 

Click on the text and Type just like a normal Word document. 
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12. Save the document to your named folder: firsnamelastinitial Address Labels 

13. Ask your teacher to show you how to put the sheet of labels into the printer. 

14. Click on Print.   

15. Close this document. 

16. Ask a teacher to check your work.   

The teacher will sign in this box. 

 

  

Many Different Labels 

17. You should have your unnamed blank document still on your desktop.  If not, Open Word again, and 

Click on the MAILINGS tab of the menu ribbon. 

18. In the Create toolbox Click on Labels.  The Envelopes and Labels Dialog Box will appear.  The 

Address Field should be blank: Erase any words in this field. 

19. In the Print Field make sure the Circle next to the words Full page of the same label is Selected. 

20. Click the OPTIONS button. 

21. Under Label Information Select the brand name in the Label Vendors Field if not already there. 

22. Also Select the label number in the Product Number Field if not already there.  

23. Click the OK button. 

24. In the Envelopes and Labels Dialog Box, Click the NEW DOCUMENT button.  A blank page of 

labels will appear. 
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25. Click in the first label and Type your address. 

26. Press the TAB key 2 times to move to the next label.  Type your friend‘s address. 

 

27. Type a few more addresses, and Save the document in your named folder:  

firstnamelastinitial Many Addresses 

28. Close this document. 

Envelopes 

29. You should have your unnamed blank document still on your desktop.  If not, Open Word again, and 

Click on the MAILINGS tab of the menu ribbon. 

30. In the Create toolbox Click on Envelopes.  The Envelopes and Labels Dialog Box will appear.  The 

Envelopes tab should be prominent (showing). 
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31. Type the name and address of the person to whom you are sending a letter in the Delivery Address 

Field. 

32. Type your name and address in the field marked Return Address. 

33. Click the OPTIONS button.  This will open the Envelope Options Dialog Box. 

 

34. Under Delivery Address Click the FONT button.  In this dialog box you can format the delivery 

address. 

35. Click the OK button. 

36. Under Return Address Click the FONT button.  In this dialog box you can format the return address. 

37. Click on the OK button.  And then Click on the OK button for the Envelope Options dialog box. 

38. On the Envelopes tab Find the word FEED.  The picture beneath the word shows how the envelope 
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should be put into the printer. 

 

39. Try putting the envelope in the printer as the picture shows.  Ask your teacher if you are correct. 

40. Click the Print button. 

41. Check your work.  Does the envelope look correct? 

42. Ask a teacher to check your work.   

The teacher will sign in this box. 

 

43. Close all open Word 

documents. 

 

  

Do the following only if Microsoft Word is a 20 day course. 

Write a Letter and Create an Envelope 

44. Open the program MICROSOFT WORD 

45. Type a letter to a member of your government (Senator, Representative, Mayer, President, etc.).  Tell 

him or her about a problem you‘d like them to fix.  Or express your opinion to him or her about 

something they have done or are planning to do. 

46. Ask a teacher to help you find the address of where to send the letter.  He or she can help you find the 

address on the Internet. 

47. Use what you have learned about envelopes to create an envelope for this letter.  When you are done, 

DO NOT print. 

48. Click the ADD TO DOCUMENT button.  You will see your envelope and then the letter.  Now every 
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time you want to print this letter you can also print an envelope for it. 

49. Save this document in your named folder: firstnamelastinitial government letter 

50. Ask a teacher to check your work.   

The teacher will sign in this box. 

 

51. Print your envelope and letter.  
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Microsoft Word: Exercise 12  
 

Creating a Resume 
 

 

You are going to begin looking for a job in the United 

States and have learned about job searching on the Internet 

through an Internet Skills class.   

In order to apply for a job it is helpful to have a resume.  

You are going to create one in this exercise using a Word 

Template. 

 

 

49. From the Desktop Open Microsoft 

Word.  (Double-click on the icon) 

3. Then Click on New, because we want 

to look for a specific template in 

order to create our resume. 

 

2. Once Word is open, 

Click on the Office 

button. 

 

 

4. The New Document 

dialog box will open.  A 

Blank Document is 

highlighted. 

 

We do not want a new 

blank document.  We are 

looking for a temple for a 

resume. 

 

Look on the left side of 

the box for the Template 

window.   

5. Use the scroll bar to read 

down the list until you 

find where it says 

Resumes or Resumes 

and CVs. 

6. Click on the words. 
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7. Microsoft Word will open up that list in 

the middle window of the dialog box.  

 

We are going to look for a simple or 

basic template.  Click on the words Basic 

resumes. 

 

8. The middle window will 

the display a lot of 

different resume styles 

and types.  Some of them 

are for specific kinds of 

jobs.  But we are looking 

for something for general 

use.   

9. Click on the one that says 

Chronological resume 

(Traditional design).  On 

the right, it will show you 

a bigger version of the 

resume.   

10. We will use this one.  

Click on the Download 

button 
 

11. You may get a dialog box asking about 

converting the document from Word 2003 

to Word 2007.   Click the OK button. 

12. Since we downloaded a document from 

somewhere else that can be considered a 

Microsoft shared folder, before we do 

anything else, let‘s save it to our named 

folder. 

 

Named folder: an individual‘s folder where that 

person‘s documents are filed. 

Shared folder:  a folder where documents are stored 

which are to be accessed/used by many individuals.  

―My Documents ―is a shared folder with many other 

folders inside of it. 

13. To Save the document to your folder, 

begin by Clicking on the Office button. 

 

In the drop down menu, Click on Save As 

because we want to relocate and rename 

the document. 

14. This step should take you to the Save As 

dialog box and the My Documents folder.  

Remember, this is a shared folder.  In it is 

your named folder. 
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15. Use the scroll bar at the bottom of the list 

of folders to look for your named folder.  

Double-click on it to open it. 

16. Once you have your folder opened, look 

at the File Name field below.   

 

17. Your name should now appear the the 

Save in field. 

18. The word Objective is in that field.  We 

want it to say something else.  It is 

already highlighted, so just type in the new 

name: Yourfirstname Resume. 

19. Click the Save button or Press the Enter 

key. 

 

20. Look at the top of your document.  It 

should now have the new file name at the 

top . 
 

21. Now that the document has been saved, let‘s take a closer look at it.  It is a Form.  See where 

the words street address is highlighted?  This means that you can fill out the information 

listed and use the tab key to move to the next piece of needed information or what is called a 

Field.   

 

[Street Address], [City, ST  ZIP Code] [phone] [e-mail] 

[Your Name] 
 22. Do not enter anything yet.  Press the Tab key.  See how it moves from street address to your 

name?  It skips the rest of your address information.  Therefore, the form has some errors in it 

and we may have to use our mouse to get into those skipped fields. 

23. Tab through the document and Look at the different fields as they become highlighted.  You 

will see that some ‗fields’ have more than one piece of information in them.  Do not tab 

beyond the end of the document. 

24. Click in the Street Address field again.  
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25. Do not bother deleting what his there, just Type your street address.  This is your resume, 

so it should have your information on it. 

26. Use your mouse to Click into the next field.  Type in the correct information. 

27. Do the same for the phone and email fields.  When you have completed that, Use the Tab 

key to go to the next field. 

28. Type in your name.  Notice how all the formatting has been done for you. 

29. Next you will need to tab twice in order to get to the next field where you enter information.  

In the Objective section of the resume Type in the objective that you worked out with your 

teacher before the exercise.  If you have not completed it, tab down to the next field, you can 

come back to this one later. 

30. When you are finished typing your objective, tab twice more to get to the Experience section 

of the resume.  We always begin with the most recent or current job first and work backward.  

You do not have to go back to the beginning of your working life.  A ten year history is 

acceptable to most employers. 

 

If you have the exact date you started your last job that is great, but if you only remember 

year, that is also acceptable.  For example: 2003-Present.  This means that the person who is 

writing this resume is still working at this job.  Type in the Dates of your last or current job. 

 

Objective 

Records management is an essential in any business.  What to file, what to keep, and more 

importantly, what to throw away is something I have learned and will continue to study both from a 

legal standpoint as well as a practical one. 

Experience 

[Dates of employment] [Company Name] [City, ST] 

[Job Title] 

 [Job responsibility/achievement] 

 [Job responsibility/achievement] 

 [Job responsibility/achievement] 

31. Tab over to the next field.  Type in the name of the Company. 

32. Tab again to the next field.  Type in the City and the State Abbreviation where the company is 

located. 

33. When you tab again, you will see that all of the next group of fields are highlighted.  If we just 

type over the highlight, it will erase what is already there.  So, we must use the mouse to click on 

the individual fields.  Click on the Job Title field.  

34. Type in your Job Title. 

35. Click on the first bullet field.  What was your major job responsibility in the position you held? 

 

____________________________________________________________________________ 
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36. Type your answer into that field. 

37. Can you think of one or two other important responsibilities of that position?  List them below, or 

Type them directly into the resume.  (Remember to click into each field.)  Then Type them into 

the resume. 

 

___________________________________________________________________________ 

 

___________________________________________________________________________ 

38. Save this document by Clicking the Save button on the Quick Access Toolbar. 

39. Fill in the information for your other jobs up to a ten year history.  Use steps 28 through 34 to help 

you. 

2003-Present Judicial Hall Korona City, MN 

Records Coordinator 

 Fill all requests for all criminal files and deliver them to the correct offices 

 Sort and file all returned files to the stacks 

 Pull, box, and label all criminal files to be stored off site 

 

2001-2004 Korona Mobile Lending Library Korona City, MN 

Librarian 

 Check in and out all resources 

 Collect all over due fees and turn them into the Head Librarian at the Korona City Library 

 Match all actual inventory to the computer inventory and investigate any discrepancies 

 Find equitable solutions to disputes between borrowers 

 

1998-2001 
Takadaya Memorial Library 

Hakodate, Oshima, 

 Hokkaido, Japan 

Assistant Librarian, Resource Department 

 Check in and out resource equipment, including projectors, microfiche, magnetic tapes, and 

books 

 Keep a current inventory of all the projectors 

 Collect all over due fees and turn them into the Head Librarian 

 

[Dates of employment] [Company Name] [City, ST] 

[Job Title] 

 [Job responsibility/achievement] 

 [Job responsibility/achievement] 

 [Job responsibility/achievement] 

40. Let‘s look at our sample resume above.  What changes did our resume writing, Sulin Tamu, need 

to make to the template to enter her work experience? 

 

_____________________________________________________________________________ 

41. Sulin Tamu, has had three jobs in the last ten years.  Therefore, she has some blank fields at the 

bottom of her list she does not need.  She will delete those by Highlighting the shaded areas on 

the actual document.  
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42. Over the highlighted area, 

Right-click to bring up the 

pop-up menu.   

43. Click on Delete Rows. 

44. If you need to make similar 

changes to your resume, Ask 

your teacher if you need help.  

45. Next we will move into the Education section of the resume.  This sample resume is designed for 

a college graduate, but do not let that put you off.  This section can be modified for a high school 

graduate or one who has or is in the process of getting a G.E.D. 

 

Sulin did not attend college.  She did graduate from high school in Japan.  She will enter that 

information.  Just like the Experience section, Click in the Dates of Attendance field and Type in 

the Dates you attended whatever schooling you are using for the resume.  (Remember, most recent 

first.) 

46. Complete the rest of the information about your education.  Again, if you need help, ask a teacher. 

47. Use the Spell Check feature to correct any mistakes. 

48. Save your resume by using the Save button on the Quick Access Toolbar. 

49. Look at Sulin‘s resume on the last page.  Does yours look similar?  If you need help with 

formatting, ask a teacher for assistance.   

 

Now you can use this resume any time you apply for a job and update it with new information as 

needed. 

 



 

Word Basics 69 Rev 3.2010 

 
121 Harbinger Lane, West Saint Paul, MN 55118 651.555.2350 sul1ntamu@gmail.com 

Sulin Tamu 

Objective 

Records management is an essential in any business.  What to file, what to keep, and more 

importantly, what to throw away is something I have learned and will continue to study both from a 

legal standpoint as well as a practical one. 

Experience 

2003-Present Judicial Hall Korona City, MN 

Records Coordinator 

 Fill all requests for all criminal files and deliver them to the correct offices 

 Sort and file all returned files to the stacks 

 Pull, box, and label all criminal files to be stored off site 

 

2001-2004 Korona Mobile Lending Library Korona City, MN 

Librarian 

 Check in and out all resources 

 Collect all over due fees and turn them into the Head Librarian at the Korona City Library 

 Match all actual inventory to the computer inventory and investigate any discrepancies 

 Find equitable solutions to disputes between borrowers 

 

1998-2001 Takadaya Memorial Library 
Hakodate, Oshima, 

Hokkaido, Japan 

Assistant Librarian, Resource Department 

 Check in and out resource equipment, including projectors, microfiche, magnetic tapes, and 

books 

 Keep a current inventory of all the projectors 

 Collect all over due fees and turn them into the Head Librarian 

Education 

1995-1999 Esan High School 
Hakodate, Oshima, 

 Hokkaido, Japan 

References 

References are available on request. 
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Microsoft Word: Exercise 13 
 

What You have Learned 
 

We are going to find and copy a shared document.  Remember, when you save it 
to work on, you must save it to your named folder. 

 Use the Start Menu and go to My Documents. 

 Use the Scroll Bar to find the folder Computers and Literacy. 

 Double-click to open the folder.  Double-click to open the Word folder. 

 Find the file Microsoft Word Certificate (unformatted) and Double-
click to open the file. 

 Save it to your named folder as Firstnamelastinitial Certificate. 

 Select all the text.  On the Home tab in the 

Editing toolbox, Click on Select and then in the 

drop down box, Select All. 

 Change on the font style to a different 

font. 

 Highlight Neighborhood House English Language 

Learning Program. 
 

 Change the font size to 20 point. 
 Click after Program to put the blinking cursor there. 

 Press Enter. 

 Click after thes to put the blinking cursor there. 

 Press Enter. 

 Highlight Certificate of Completion. 

 Change the font to 28 point. 
 Highlight Microsoft Word Basics Workshop 

 Change the font to 36 point. 
 Highlight [type your name]. 

 Change the font to 72 point. 
 Type your name. 

 Highlight [type the Month, Day, Year] 
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 Change the font to 36 point. 
 Type today‟s date or a date specified by the teacher. 

 Select all. 

 Click the Center Align button to center the words. 

 Use spell check. 

 Correct any spelling mistakes. 

 Adjust, Rearrange, or Resize the images on the certificate. 

 Change at least one of the images on the certificate.  On the Insert tab in 
the Illustration toolbox, Click on Clip Art button to open the window where 

you can search for new images.  You can also get them from the Internet. 

 Change the Background of the certificate.  On the Page Layout tab you 

have two choices.   
 

1) In the Page Background toolbox, Play with the three tools listed: 
Watermark, Page Color, Page Borders.  Look at but do not add a 

watermark to your certificate.  If you add one you can always use the UNDO 
button to make it go away. 

 
2) In the Themes toolbox, Look at the different Themes available.  Check 

out the Colors you can change as well.   
 

Make any changes you like. 

 Show the Teacher! 

 Ask for help printing your certificate! 

CONGRATULATIONS! 


